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WordSpring is for teachers who want an easy-to-use, methodology-neutral resource 
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However, it is to Carol Murray to whom we owe the greatest thanks. One of our 

founders in the late ‘80s, she became quickly one of our best friends. When she 

passed away in 2010, she left behind teachers and students all over the country 
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WordSpring is based on Carol’s pedagogical approach to literacy instruction, that in 

turn draws on the concepts of Orton, Gillingham, and Slingerland. Even the idea for 
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Chapter 1 – About WordSpring 
 

WordSpring is for teachers who want a simple to learn, easy to use, 

methodology-free, comprehensive resource to support the inclusion of 

phonics into their literacy programs. WordSpring has extensive library of 

words and lists organized in 26 categories that illustrate all the important 

phonics concepts needed for decoding, spelling, and vocabulary 

development. The categories begin with one-syllable words containing one 

short vowel and expand in complexity to include words that require the 

application of specific syllabification rules and accenting hints. The lists, 

because they include words from beginning to advanced levels, are suitable 

for students of all ages and skills. WordSpring is adaptable to most teaching 

methods. 
 

Teaching language arts, especially to dyslexic students, is challenging. 

Lessons must be structured to address the specific strengths and weaknesses 

of the students as well as their ages and skills. WordSpring assumes that the 

teacher knows how to do this, that she has in mind the structure of the lesson 

that she proposes to give, and that she needs word lists to illustrate the 

concepts to be taught. WordSpring makes assembling these lists easy and 

quick. It provides printouts of the word lists for incorporation into lesson 

plans, for giving to students, and for other purposes and allows the word lists 

to be saved in files for later use. 

 

Scope & Sequence 
 

WordSpring is a companion to Lexia’s other lesson planning tool: Scope & 

Sequence for Literacy Instruction by Carol Murray. Comprehensive scope 

and sequence guidance is available in this text book. It provides direction for 

what concepts to introduce, when to introduce them and how much students 

can be expected to learn within particular time frames. Scope & Sequence 

provides guidance on what words the lists used in a plan should contain at 

different stages of instruction. 
 

WordSpring replaces Lexia's earlier lesson planning tool, LessonPlanner, that 

helped teachers structure complete lesson plans in the format used in Orton-

Gillingham approaches, and, in particular, the Slingerland approach. 

WordSpring provides word lists that illustrate the concepts important for 

students to master, but it does not impose a particular structure on lesson plans. 
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You can view and download Scope & Sequence for Literacy Instruction at our 

website: www.LexiaNet.org.  

 

WordSpring 3.1 Features 

 

WordSpring 3.1 is a 64-bit upgrade to WordSpring 3.0 (32-bit) that is 

required for newer versions of Macintosh and Windows operating systems. 

For example, WordSpring 3.0 will not operate on Mac OS X version 10.15 

(Catalina) or later operating systems. However, WordSpring 3.1 will operate 

on these more recent versions of Mac OS X from 10.13 (High Sierra) to 

10.15 (Catalina) and later and Windows 10 64-bit version or later. A second 

big change is WordSpring 3.1 is distributed for free, no registration or code is 

required. Feel free to share WordSpring 3.1 with colleagues. Otherwise 

WordSpring 3.1 is the same as WordSpring 3.0.  

 

WordSpring 3.1 and WordSpring 3.0 both provide the following features 

that make them the most complete and flexible word list resources 

available: 
 

• 18,000 dictionary (real) words from which over 650 different word 

lists have been constructed. Each of these lists can be arranged 

easily and quickly in multiple ways to support literacy instruction 

at all levels. There are 2000 more words and 250 more word lists in 

WordSpring 3.1 than in the previous version. 
 

• 6000 one-syllable short and long vowel nonsense words having 

consonant-vowel-consonant (cvc) or vowel-consonant-e (v-e) 

structure and many of the di/trigraph, phonogram, r-controlled 

phonogram concepts that students should learn to decode. 
 

• the 650 word lists are organized in 26 categories that illustrate all 

the important phonics concepts needed for decoding, spelling, 

and vocabulary development. 
 

• the word lists now include over 90 Latin roots, 100 Greek 

combining forms, 80 prefixes, and 100 suffixes and endings. The 

coverage of these morphological elements is comprehensive. In 

addition, WordSpring now has a comprehensive list of 

homographs, words spelled the same but pronounced differently. 
 

http://www.lexianet.org/
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• the ability to select di/trigraphs (e.g., ph and dge), phonograms 

(e.g., ai and eigh), affixes (e.g., -able and - cial), Latin and Greek 

roots (e.g., ject and flex), homonyms (e.g., altar/alter), and 

homographs ((e.g., read (rēd),read (rəd)) to mention but a few, 

that you want in your lesson. 
 

• the ability to select words of 1, 2, 3 or more syllables or words that 

have consonant-vowel-consonant (cvc) structure and to add 

nonsense words to your word lists. 
 

• the ability to select either dictionary words or nonsense words. 
 

• the ability to select words illustrating over a dozen specific 

spelling generalizations and rules from the double f, 1, s, z 

generalization to the extended 1-1-1 rule. 
 

• the ability to select words that apply the four syllabification 

rules with the corresponding syllable patterns. 
 

• the freedom to choose lists arranged in random, consonant-

vowel-consonant, or alphabetic order, as you prefer. 

 
• teaching tips and guidance for language concepts (lists), descriptions 

of spelling and syllabification rules, and definitions of endings, 

suffixes, Greek forms, and Latin roots. These are all available in a 

document that can used to guide instruction. 

 
• the power to customize lists to meet students' specific needs, to build 

on previous lists, and to share lists with other teachers by e-mail, 

network, or disk. 
 

• the flexibility to print lists in several formats including large 
print decoding and spelling work sheets and student stick-on 

labels with pronunciations, if desired. Words can be sequence 
vertically or horizontally and print formats can be customized to 
meet special requirements. 

 

• dictionary pronunciations compatible with Orton-Gillingham-based 

approaches for all 24,000 dictionary and nonsense words.  
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Chapter 2 - Getting Started 
 

Computer requirements 
 

To use WordSpring 3.1 on a Windows computer the following 

configuration is required: 
 

• A Windows-based computer with at least 1 gigabyte (GB) of 

random-access memory, a 64 bit CPU, a hard drive with at least 

1GB of space available for the WordSpring program, and a color 

monitor with at least 1024 x 768 pixels resolution 

• Windows 10 64-bit version or later operating system 

 

To use WordSpring 3.1 on a Macintosh, the following configuration 

is required: 
 

• A Macintosh with at least 1 gigabytes (GB) of random-access 

memory, a hard drive with at least 1GB of space available for the 

WordSpring program, a color monitor with at least 1024 x 768 

pixels resolution 

• Mac OS X version 10.13 (High Sierra) or later operating system 

 

What You Should Know 
 

You should know how to structure your language arts lesson, that is, know 

what phonics concepts you want to teach. WordSpring will help you construct 

the word list to use in teaching these concepts but provides only limited 

guidance about scope and sequence. For help in this area, users will find 

Scope Sequence for Literacy Instruction by Carol Murray (available at 

www.LexiaNet.org ) of value. 

 

Installing WordSpring 
 

On both Macintosh and Windows, the first few installation steps are the 

same: 
 

- Before you install WordSpring 3.1 remove any older version of 

WordSpring that is on your computer. It usually will be in folder 

named "WordSpring 2.5 or 3.0" or something similar. On Windows 

use the Add or Remove command that is accessed through the 

Control Panel or through Settings. Double click on the Add or 

http://www.lexianet.org/
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Remove Programs icon, select WordSpring, and click the Remove 

button. On Macintosh move the Lexia WordSpring folder to Trash 

and empty Trash. Save any word lists you want to preserve that are 

in your Lexia WordSpring Folder in a new folder named something 

like "Old Lexia WordSpring Data". 
 

- Exit all other applications that are running on your computer by 

clicking File > Exit (Windows) or File > Quit (Macintosh). 
 

- Download the Lexia WordSpring application from the 

www.LexiaNet.org website.  
 

- The ReadMe file is one of the files in the Documentation 

directory within the WordSpring 3.1 directory. We suggest that 

you read it for information about installation and about the 

software. The User Manual is also within the Documentation 

folder. 

 

Completing Installation on Windows 
 

On Windows complete the installation process by doing the following: 
 

- Double click on the Setup icon from the download to start the 

installation. The software will be installed in your Programs 

folder unless you choose to install it somewhere else. 

 
- When the installation is completed, you should restart your 

computer. An icon for starting WordSpring will be placed in the 

Programs list that can be opened from the Start menu. A shortcut to 

WordSpring will also be placed on to your desktop. 

 

Completing Installation on Macintosh 
 

For Macintosh the installer is downloaded from the www.LexiaNet.org 

website. Keep in mind you must have admin privileges to install as the 

WordSpring application is placed in the /Applications directory. 
 

http://www.lexianet.org/
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With this in mind, complete the installation on Macintosh by doing the 

following: 
 

- Double click the appropriate installer icon to start the installation 

process and follow the instructions that appear on your screen. The 

software will be installed in your Applications folder. 
 

- If you discover the fonts don’t look correct, you may have to install 

manually the special font (LPCourier) that WordSpring uses to 

display pronunciations in your own User’s Fonts Book. 

(Applications > Font Book > User). In some sites this special font 

is already part of the standard system Fonts folder configuration, 

and you do not have to worry about installing it. To determine if it 

is already installed, open the Font Book, click on Computer, and 

look for LPCourier in the Font list. 
 

- To install LPCourier open your Font Book, click on User, and then 

click on the “+” under the font list. This will open a file dialog 

box. Click to the WordSpring 3.1 directory in the applications 

directory, double click the Documents folder, and then double 

click on the LPCourier icon. It will then be installed in your Font 

Book. 
 

- When the installation is completed, you should restart your 

computer. An icon for starting WordSpring will be placed on 

your desktop. You may want to move this icon to the Dock so 

that it is easily accessed. 

 

The installation process creates the Lexia WordSpring 3.1 folder in your 

Programs Directory (Windows) or Applications Folder (Macinstosh), adds 

Lexia WordSpring to the Programs list in the Start menu (Windows), and 

places a Lexia WordSpring icon on your desktop (Macintosh). Before starting 

WordSpring we suggest that you print out or read the ReadMe file and the 

WordSpring User Manual. They are both in the Documents folder that is in the 

WordSpring 3.1 folder. The User Manual and the ReadMe files are in Adobe 

Acrobat (pdf) format.1 

 

 
1 If you do not have Adobe Acrobat Reader already installed on your computer, you can obtain it from the Adobe website, 

www.adobe.com. 
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Starting WordSpring 
 

To start WordSpring: 
 

- Click the Lexia WordSpring icon on the Desktop. 
 

- If a WordSpring icon is not on the Desktop, you can start the 

program in Windows by clicking Start > Programs and then 

WordSpring in the list of programs or by clicking on the 

WordSpring.exe file in the WordSpring 3.1 folder. On the 

Macintosh you should click on the WordSpring icon within the 

Lexia WordSpring 3.1 folder. 
 

When the application starts you will be brought to the home screen of 

WordSpring. 

 

Adjusting the Display 
 

There are two adjustments you should make to the way in which WordSpring 

is displayed. The first is to adjust the size of the WordSpring panel so that it is 

wide enough to make all the windows visible and high enough to show all the 

entries in the [Categories] window. To adjust the WordSpring screen, grab the 

lower right corner of the screen with the mouse cursor and drag it so that the 

screen has the desired size. You can also just click on the Maximize button at 

the top of the screen. 
 

The second is to adjust the number of pixels used by the display monitor so 

that the font used by WordSpring is readable. This adjustment is very much a 

matter of individual preference. We have found that a resolution of at least 

1024 X 768 to be desirable. If there are fewer pixels, you will have to scroll 

the windows of the WordSpring panel to see all the information. 

 

To set the display resolution in Windows: 
 

- Click on the Start button at the lower left of the display. 

- Click on Settings and then Control Panel. 

- Click on Display and then the Settings tab near the top of the 

display. 

- Slide the screen area pointer left or right so that it shows the 

desired resolution. 
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To set the display resolution on Macintosh: 
 

- Click on Preferences under the Apple menu at the top left of the 

display. 

- Click on Displays and select the desired resolution. 

 

Documentation 
 

Several documents are provided with WordSpring to help you use the 

software. They are all in the Documentation folder in the Lexia WordSpring 

3.1 folder that the installation process puts on your computer. The 

Documentation folder contains: 
 

• the ReadMe file that has the latest information about installation 

and operation; 

• this User Manual; 

• the Guided Tour to WordSpring that provides an overview and 

demonstration of what WordSpring provides and how to use it; 

• a compendium of all the keywords, definitions, and teaching tips for 

each of WordSpring’s word lists; 

• the LPCourier font that WordSpring uses; 

• The LPCourier font legend that describes the keystrokes used in a 

document to form the diacritical marks for pronunciation. 

 

The user manual can also be accessed when running WordSpring by 

clicking on Help in the menu bar and selecting User Manual. 
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Chapter 3 - Using WordSpring 
 

 

WordSpring is simple to use, and this part of the manual is short. We will 

show you, through examples, how to do the following: 
 

• create word lists 

• print lists for use in class 

• save lists on your hard drive for use at a later time or to 

incorporate in your lesson plan document 

• modify lists you have saved 

 

It is helpful to know that WordSpring has been built using another 

software system called a database management system. It provides 

facilities for organizing the data that lie at the core of WordSpring. 

 

An Overview of WordSpring 
 

Word lists are created using the WordSpring main panel, which has three 

main windows as shown in Figure 12: 
 

• the [Categories] window that is used for accessing the word lists 

available in WordSpring; 
 

• the [Examples] window that is used for displaying example 

words from these word lists; 

 

• the [User Selections] window that is used for assembling words 

into lists that will be used in a lesson. 
 
 
 

 
2 The figures show WordSpring screens as they appear on Macintosh. Windows screens differ slightly, but the functionality 
and operation are the same. 
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Figure 1. WordSpring screen showing the three primary windows and all 26 categories in 
the [Categories] window. 

 

WordSpring divides word lists into a set of 26 categories, each of which 

illustrate a key decoding, spelling, or vocabulary building concept. Each 

category is in turn divided into subcategories that provide specific examples 

of the concept illustrated by its parent category. In this structure, for example, 

closed syllables (also referred to as short vowels) is a category and the six 

vowels (a, e, i, o, u, and y) are the subcategories. 
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To create a word list of short vowels: 
 

- Select the category by double clicking with the mouse on the 

closed syllable (short vowel) category name in the [Categories] 

window or by clicking on the [+] sign (Windows) or the [  ] 

symbol (Macintosh) to the left of the category name. The 

subcategories will then show. 
 

- Click on the subcategory “i”, and a list of words illustrating this 

vowel with its short vowel sound will appear in the [Examples] 

window in the middle of the panel. There are a number of ways in 

which you can filter and order this list to obtain words of desired 

difficulty. These are discussed later. 
 

- Double click a word in the [Examples] window that you want to use 

in the lesson. It will move to the [User Selections] window on the 

right of the screen. There are a number of ways that you can move 

words to the [User Selections] window. These also are discussed 

later. Double click on other words in the [Examples] window to add 

them to the list in the [User Selections] window. 

 
- Print the word list in the [User Selections] window by clicking 

Print in the menu bar at the top of the screen, then clicking Lists, 

and then choosing one of the printing formats provided in the 

dialog box that appears. 
 

- Save the word list so that the list is available for use later or for 

reformatting with your word processor by clicking File > Save in 

the Menu Bar at the top of the screen, selecting a folder in which 

to save the list, and assigning a name to the list. 

 

That’s basically all there is to it. WordSpring, however, provides many other 

facilities to make the process of creating appropriate word lists more flexible, 

easier, and faster. These are discussed in the next few sections. 

 
Categories & Subcategories 

 

The [Categories] window is on the left side of the main WordSpring screen. 

All the lists in the WordSpring database are grouped into 26 categories, 

visible in the [Categories] window in Figure 1. Each category focuses on an 



 

 

 

WordSpring     User Manual 
 

 
 

12 

important decoding, spelling, or vocabulary concept that students should 

master, for example: closed syllables, spelling generalizations, and Latin 

and Greek roots. The 26 categories encompass all the principal concepts 

that should be taught in a literacy program for decoding, spelling, and 

vocabulary development. Related categories are grouped together in the 

[Categories] window and separated from other groups by dashed lines. 
 

• When a category is selected by clicking on it, a brief description of 

that category appears below the [Categories] window. 
 

The categories are divided into subcategories, each illustrating a different 

application of the concept represented by its parent category. For example, 

the closed syllable (closed vowel) category is divided into six 

subcategories, one for each vowel (a, e, i, o, u, and y). 
 

• To expand a category to see its subcategories, click on the plus 

sign [+] (Windows) or the [  ] symbol (Macintosh) to the left of 

the category name or simply double click on the category name. 
 

In Figure 2 we have expanded the closed syllable (short vowel) category so 

that the six subcategories are revealed. When the category is expanded, the 

symbol to the left of the category name changes from a [+] to a [-] (Windows) 

or from a [  ] to a [  ] (Macintosh). 
 

When a subcategory is selected and a keyword is available to illustrate it, the 

keyword and its pronunciation are presented below the [Categories] window. 

In addition, descriptions or definition of the subcategory, tips for how to teach 

the concept represented by the subcategory and other useful information are 

provided in this window. 
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Figure 2. Closed syllable category expanded to show subcategories. Note explanation of 

the closed syllable category below the [Categories] window. 

 

Occasionally, you will find that you have opened several categories and 

that the number of items in the [Categories] window is too large and 

scrolling through the long lists is tedious. 

 

• To collapse all the lists of subcategories and restore the 
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[Categories] window to its original appearance with only the 26 

categories showing, click on the label “Categories” above the 

[Categories] window. 
 

There is also a Collapse All Lists command in the Utility menu in the 

menu bar. This command can also be initiated by typing CTRL+F 

(Windows) or +F (CMD+F) (Macintosh). 

 

Creating a Word List 
 

We will now work through a particular example in which we create a word 

list for a beginning decoding lesson introducing the closed syllable (short 

vowel) “i” and reviewing the closed syllable “a”. We will illustrate different 

ways for creating the desired word list. 

 

Getting Word Examples 

 

The first step is to get a set of words illustrating the closed syllable “i” 

that are candidates for use in the lesson. To get these word examples, 

select the closed syllable (short vowel) category in the [Categories] 

window: 
 

- Click once on the closed syllable (short vowel) category to select it. 

It is the second entry in the list of categories. Note that a 

description of this category appears just below the [Categories] 

window. 
 

To see the subcategories: 
 

- Click on the [+] symbol (Windows) or the [  ] symbol 

(Macintosh) to the left of the category name. 
 

Or 
 

- Double click on the category name. 
 

The list of six Subcategories, a, e, i, o, u, and y, appears. 
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Figure 3. Examples of closed syllable “i” words shown in the [Examples] window. 

 

To obtain a set of words containing the closed syllable “i”: 
 

- Click on “i” in the [Categories] window and note that the key word 

[i]nch and its pronunciation appear below the [Categories] window. 

Note the keyword, its pronunciation, and the teaching tip in the text 

window below the [Categories] window. 
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A list of words containing the closed syllable “i” words appears in the 

[Examples] window in the middle of the screen as shown in Figure 3. 

 

Working with the Examples Window 

 

Words in the [Examples] window can be arranged in several ways and can 

be restricted to words composed of a specific number of syllables or to 

words that have a consonant-vowel-consonant (c-v-c) structure. This process 

of restricting the words in a subcategory that appear in the [Examples] 

window is called “filtering”. 
 

You also have the option of displaying nonsense words rather than dictionary 

(real) words. In this version of WordSpring nonsense words are limited to 

one-syllable, short and long vowel words of consonant-vowel-consonant (c-v-

c) or vowel-consonant-e (v-e) structure. 
 

The small [Display] window just below the [Examples] window is used to 

select the filter that will be applied to the words in the subcategory. Only 

words satisfying the filter will appear in the [Examples] window. The 

[Display] Window allows you to restrict the words in the [Examples] window 

to 1-syllable words, 2-syllable words, 1- or 2- syllable words, 3-or more 

syllable words, all words without regard to number of syllables, or to words 

that have a c-v-c structure. WordSpring filters out the words that are not of the 

type selected. Initially, the 1 or 2 syllable filter is selected when you start 

WordSpring. 
 

Just below the [Display] Window are two choice buttons that allow you to 

select either dictionary or nonsense words. Nonsense words are useful for 

building decoding and spelling skills because the student cannot use word 

recognition to by-pass explicit decoding and spelling processes. However, it 

should be noted that pronunciation of many nonsense words is not unique. A 

single construct, such as the phonogram ea, may have several 

pronunciations (as in eat, steak, and head). It may not be possible to 

determine which one to use in a particular nonsense word. This ambiguity 

provides a valuable teaching opportunity for discussing the several ways a 

phonogram, digraph/trigraph, or other construct of our language can be 

pronounced for both decoding and spelling. 
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The small [Sort] window below the [Display] window is used to arrange the 

words in the [Examples] window different ways. This operation is called 

Sorting. When WordSpring is started, the Unsorted option is selected, which 

means that words appear in random order in the [Examples] window. The 

other sort options allow you to arrange the words in alphabetic order, by 

number of syllables, or in consonant-vowel-consonant (c-v-c) order. The c-v-

c option displays simple c-v-c (one consonant, one vowel, one consonant) 

words appear first, followed by c-v-cc words, followed by cc-v-c words, 

followed by cc-v-cc words, and followed by cc-v-ccc and ccc-v-ccc words. 

Consonant-vowel-consonant ordering is available only for 1-syllable words. 
 

It may seem strange to have the c-v-c option available in both windows, but 

the c-v-c option as implemented in WordSpring filters out words that are not 

c-v-c words and also arranges the c-v-c words by the complexity of their c-v-c 

structure. Because c-v-c is both a filtering and a sorting operation, c-v-c 

appears both in the [Display] and in the [Sort] windows. When it is selected in 

one window, the other window is automatically set to c-v-c. To unselect c-v-c 

words, you must choose another option in the [Display] window, for examples 

2-syllable words. You cannot return to multi-syllable words by choosing 

another option in the [Sort] window, for example alphabetical. 
 

The [Maximum words] window below the [Sort] window determines the 

number of words that will appear at any one time in the [Examples] window. 

This is initially set to 100 words, all of which can be seen if you use the 

scroll bar at the right of the [Examples] Window. You can change the 

Maximum words setting by typing a different number into the [Maximum 

words] Window. 
 

Note the red numbers at the upper right corner of the [Examples] window, 

100/1660 (or numbers close to these). The first of these numbers indicates 

that there are 100 words actually in the word list currently shown in the 

[Examples] window. The second number indicates the total number of words 

in the subcategory you have chosen that have the number of syllables set in 

the [Display] window. The [Display] window is set to 1 or 2 syllables. The 

red number 1660 at the upper right corner of the [Examples] window is the 

number of 1- or 2- syllable words in the closed syllable “i” subcategory. If 

there are no words in the list for the Display settings you have chosen, the 

message “No words found” will appear instead of the numbers. 
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When WordSpring encounters lists longer than the number set for [Maximum 

words], it displays a randomly chosen sample of about ten per cent of all the 

words in the list. In Figure 3, the numbers at the top right of the [Examples] 

window indicate that there are 100 words in the first sample of the full list of 

1660 words. A second sample of words from the full list can be obtained by 

clicking again on the subcategory name in the [Categories] window. 
 

Now select a 2-syllable word in the [Examples] window by clicking on it 

once. Note that the pronunciation, syllabification, and accenting of the 

selected word appears below the [Examples] window. The pronunciation uses 

standard dictionary pronunciation symbols compatible with Orton-Gillingham 

instruction. Pronunciations are available for all the words in the database. 
 

We have described all the facilities associated with the [Examples] window. 

Let us now illustrate how to use these facilities to obtain a word list for our 

lesson in which we introduce the closed syllable “i” and review the closed 

syllable “a”. 
 

To obtain words containing only one syllable, we must change the 

[Display] setting. To do this: 
 

- Click on the small arrow at the right of the [Display] window 

and the filter options will appear in a pop-up list. 
 

- Click on 1 syllable and note that the words in the [Examples] 

window have changed. Only 1- syllable words appear. Also, the 

word count at the top right of the screen has changed. 
 

If you were interested in working with longer words, you could have 

selected 2 syllable or 3 or more syllables in the [Display] window. For 

each of these you will get different lists of words corresponding to the 

filter selections. 

 

Check to make sure that Dictionary Words is selected just below the 

[Display] window. If you want to work with nonsense words, click in the 

circle just to the left of “Nonsense Words”. Remember only one syllable 

nonsense words are in the database so if you select 2 syllables in the 

[Display] window, no words will appear in [Examples] and the message “No 

words found” will appear above the [Examples] window. 
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If you wanted the lists in the [Examples] window to be shorter than 100 words 

to simplify word selection, you should type some other number in the 

[Maximum words] window. To see what happens: 
 

- Type 15 into the [Maximum words] window. 
 

- Press the Enter (Windows) or the RETURN (Macintosh) key. 

Note that the list is shortened and the word count numbers change. 

 
Since we are making a list for a beginning class, we might want to work 

first with simple consonant-vowel-consonant words and then go to more 

complex words. It would be useful, therefore, to have the words in 

[Examples] in c–v–c order. To do this: 
 

- Click on the small arrow at the right of the [Sort] window and the 

sort order options will appear in a pop-down (or pop-up) list. 
 

- Click on c–v–c. 
 

Note that the words in the [Examples] window are now ordered by their 

consonant-vowel-consonant composition. Simple c-v-c words appear first, 

followed by c-v-cc words, followed by cc-v-c words, followed by cc-v-cc, 

and followed by cc-v-ccc words. When c-v-c order is selected in the [Sort] 

window, the [Display] window is automatically set to c-v-c to reflect the fact 

that only 1-syllable, c-v-c words are shown in the [Examples] window. 
 

You could also have selected c-v-c in the Display window, and you would 

have obtained the same list of words in [Examples]. 

 

Selecting Words for Your Lesson 

 

Words that you will actually use in your lesson are assembled in the [User 

Selections] window at the right of the screen. WordSpring provides a number 

of ways for moving words into this window. The [User Selections] list can be 

printed for use in class or saved to a file. 
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You can move individual words from the [Examples] window to the [User 
 

Selections] window by: 
 

• Double clicking on the word; 

 

• Clicking once on the word (selecting the word) and dragging it to 

the [User Selections] window; 

 

• Clicking on the word and then clicking the blue single arrow 

button [  ] between the two windows. It is the uppermost of the 

set of five buttons located there. 
 

When you drag the word, it can be placed anywhere in the [User 

Selections] word list. When you double click or use the [  ] button, the 

word is appended to the end of the list. 
 

• Experiment with these commands by using them to move some 

closed syllable “i” words from [Examples] to [User Selections]. 
 

There are two ways of moving groups of words to [User Selections]: 
 

• Click the [10%] button, which is the second of the buttons located 

between the [Examples] and the [User Selections] windows. 

Approximately 10% of the words in the [Examples] list, selected 

at random, will be moved to [User Selections]. 
 

• Click the blue double arrow [ ] button and all the words in the 

[Examples] list will be moved. 
 

There are also three ways to remove words from the [User Selections] 

Window: 
 

• Click on the word and drag it out of the [User Selections] 

window and into the [Examples] window. 
 

• Click on the word in [User Selections] and then click on the red 

single arrow [ ] button. 
 

• To remove all words from [User Selections], simply click on the 

red double arrow [ ] button. You will be asked to confirm this 

action, and when you do the user [Selections] Window will be 

cleared. 
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To enter any word you want in the [User Selections] list: 
 

- Type the word into the [Add Word] window located just below the 

[User Selections] window. 

 

- Click at the point in the [User Selections] list at which you want the 

word to be inserted. 

 

- Press Enter (Windows) or RETURN (Macintosh), or click on the 

blue single arrow [  ] button, and the word will be appended to 

the [user Selections] list. 
 

Pronunciations are available for words in [User Selections] that came from 

the [Examples] window. Pronunciations are not available for words typed in, 

unless they happen to be in the WordSpring database. To obtain the 

dictionary pronunciation: 
 

- Click on the word, and the pronunciation will appear below the 

[User Selections] window. 

 

Reordering Your Word List 

 

You can change the order in which words appear in the [User Selections] 

window simply by selecting the word and dragging it to the desired position 

in the list. You can also arrange the words in alphabetic order by clicking in 

the box to the left of “Sort List Alphabetically” just below the [User 

Selections] window. 
 

Note: Once the list has been sorted alphabetically, it cannot be 
 

returned to its original ordering. 

 

Adding Words from Other Subcategories 

 

Words can be added to the [User Selections] window from other 

subcategories. We will illustrate this by adding closed syllable “a” words 

for review to the [User Selections] list: 
 

- First, make sure the words in the [Selections] window is not 

being alphabetized. If there is a check in the Sort List 

Alphabetize check box, cancel it by clicking in the box. 
 

- Click on the closed syllable “a” subcategory. Closed syllable “a” 

words will appear in the [Examples] window in c-v-c order if this 

option is still selected in the [Sort] window. 
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- Move the words you want to the [User Selections] window using 

one of more of the methods described above. You should now 

have a list containing both closed syllable “i” and closed syllable 

“a” words. 
 

- Put the words in the [User Selections] window in the order you want 

by clicking and dragging on the words you want to move. 
 

You can build lists containing selections from as many categories and 

subcategories as you like by continuing in this manner. 

 

Adding Titles and Labels to Lists 
 

A simple way of adding a title to a list is to type the title into the Add Word 

box below the User Selections window and then move that title to the 

appropriate position in the list. It is a good idea to type the title all in capital 

letters to distinguish it from the words in the list. You can use the same 

method to put a label in the middle of a list, for example, to identify the 

types of words that follow. 
 

You can also add a blank space after or before the title by typing a space in the 

Add Word box and then dragging that word into the list. This is useful for 

setting off a Title or for separating different parts of a list. 

 

Printing Your Word List 
 

You can print the word list in the [User Selections] window in several 

different formats. There are two groups of formats: 
 

• Word lists can be printed on standard paper in one or more 

columns in any of several different font sizes. 
 

• Words can also be printed on labels that students can paste in 

their notebooks. 
 

You also have the choice of printing just the words or printing the words 

together with their pronunciations. Lists without pronunciations can be printed 

sequenced vertically in one-column, two-column, three-column formats with 

the paper in the usual portrait orientation. The more compact three-column 

format is provided for teachers to use in class. Lists can also be printed with 

words sequenced horizontally and the paper in the landscape orientation. 
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Three font sizes are provided: standard (Std), which is 14 point, large (Lrg), 

which is 18 point, and extra large (XL), which is 24 point. Words are spaced 

vertically by 1.5 lines to make them easier to read. When you print the words 

together with their pronunciations, only a two-column vertically-sequenced 

format is provided because the words and pronunciations are printed side-by-

side. 

 

Label formats are similar, but only the Standard and Large font sizes are 

available. 
 

To print the word list that is in the [User Selections] window: 
 

- Select the Printing menu from the menu bar at the top of the 

screen by clicking on it. 
 

- Select Lists or Labels depending on your preference. For this 

exercise, we suggest you select Lists. Several print formats will be 

displayed. 
 

- Select the print format you want from the list presented in the 

dialog box by clicking on it. 
 

- Click on the Print button at the bottom right corner of the dialog 

box. 
 

- Click on the desired choices on the standard Print Setup and 

Print dialog screens that then appear. 

 

Saving and Retrieving Saved Lists 
 

You can also save your list to a file. You can do this by using the standard 

Save command in the File menu. When you choose Save, a standard file 

dialog screen appears and you can select a folder in which to save the list. 

After you make this selection, you must assign a name to the list. Word lists 

are stored in “.txt format”, which simply means that they are simple text 

documents with very simple formatting. These documents can be opened by 

your word processor and reformatted in the usual way. 
 

To save a list: 
 

- Select File > Save from the menu bar at the top of the screen. A 

dialog screen will appear. In Windows the dialog screen will be set 

initially to save your list in the Default directory. You can use a 
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different directory, by navigating to it in the standard way using 

the dialog screen. On the Macintosh, we recommend you select a 

folder in which to save lists. This folder can be anywhere you wish 

but having it in your documents folder is a good start. 
 

- Type the file name that you want to associate with this list. You 

might want to use a file name that includes the date or the class 

name. If you include the date, some people suggest you use the 

format: YYYYMMDD, such as 20131018 WS List, which will 

result in file lists that are in chronological order. 
 

- Click the Save button to save the file. 
 

To retrieve a word list that you saved: 
 

- Select the File menu from the menu bar at the top of the screen by 

clicking on it. 
 

- Select Open. The standard Open file dialog screen will appear. 
 

- Select the file you want to open. 
 

- Click the Open button and the word list you selected will be placed 

into the [Examples] window, replacing any list that is already there. 

You can then filter or rearrange the words in the combined list as 

described above and move selected words to the [User Selections] 

window for use in your lesson. 
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Chapter 4 - Creating Custom Printing Formats 
 

It is quite simple to create custom printing formats (also known as printing 

templates) that present printed word lists in a specific font, number of 

columns, or number of words per page. This is done with the Label Editor that 

is accessed by a command in the Printing menu of the Menu Bar. 
 

A word list is simply a set of labels printed on plain paper. Printing formats 

are designed by specifying the layout of a set of labels arranged in the 

number of columns and the number of rows that match your needs. Each 

word or each word-pronunciation pair is printed on a single label. So a word 

list of 20 words or 20 word-pronunciation pairs will require 20 labels. 

Because word lists are treated as an arrangement of labels, they were created 

and are edited with a software tool call the Label Editor. 
 

To create a custom printing format: 
 

- Make sure there are around 20 or 30 words in the User 

Selections window. These will be required to test the format 

that you create. 
 

- Select Print Format Editor in the Printing menu of the Menu Bar 
 

- Click the Label Editor button in the Edit Templates panel that 

appears. The Label Editor panel will appear. 

 

Editing a Print Format 
 

It is easier to create a new printing format by editing an existing one, rather 

than starting from scratch. The printing formats provided with WordSpring 

can be used as the starting point for creating a new format or adjusted if they 

are not exactly what you want. WordSpring is delivered with a number of 

standard print formats. These are the ones that appear the first time you ask 

WordSpring to print the [User Selections] list. These formats are stored in the 

WS Printing Formats folder that is within the Documentation folder inside the 

Lexia WordSpring 3.1 folder. 
 

To load an existing printing format for use with the Label Editor: 
 

- Open the Label Editor as described above. 
 

- Click the Load button at the top of the Editor panel, and a 

standard file dialog box will appear. 
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- Locate the printing format that you want to edit in the WS 

Printing Formats folder within the Documentation folder inside 

the Lexia WordSpring 3.1 folder located in Applications 

(Macintosh) or Programs Folder (Windows) (or some other folder 

you have used for storing printing formats). If you click on the 

small arrow to the right of the load button, a list will appear of all 

the print formats originally installed with WordSpring 3.1. Print 

formats you create will not be in this list. To have all your print 

formats available for editing, we recommend using the Load 

button and saving print formats in WS Printing Formats folder or 

a folder of your choice. 
 

- Click Open. The label design and layout from the selected 

format will be loaded into the Label Editor and be ready for 

editing. 

 

Layout Design 
 

It is usually best to start the print format design by specifying how the labels 

containing the words or words and pronunciations will be laid out on the 

printed page. To do this first: 
 

- Click on the Layout tab at the top of the Label Editor panel. 

The Layout Editor will appear (shown in Figure 4). 
 

Then: 
 

- Specify whether you want the page to be printed in portrait 

(vertically) or landscape (horizontally) by clicking the Print 

Setup button at the bottom of the Layout section of the left of 

the panel and select the orientation desired. If you pick 

landscape (horizontal) then you need “horizontal” in the print 

format name you save otherwise the orientation is ignored when 

printing. 
 

- Specify whether you want the words in the list to flow down one 

column and then down the next (vertical label order) or across a 

row and then across the next (horizontal label order) by selecting 

from the Label Order drop-down menu at the top of the dialog 

box. 
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- Choose the number of columns that you want by entering the 

appropriate number in the Column box. Remember that 

pronunciations are on the same label as their word. If the word and 

pronunciation are arranged side-by-side, one column of labels will 

contain both, but they will appear as two columns on the printed 

page. As you increase the number of columns, you decrease the 

width of the labels and the number of letters that will fit on a label. 

For large font sizes or long words, the maximum number of 

columns will be two. 
 

- Choose the number of words (rows) that you want in each column 

by entering the appropriate number in the Rows box. 
 

 

Figure 4. Layout Design panel of the Label Editor 



 

 

 

WordSpring     User Manual 
 

 
 

28 

 

Next, adjust the margins and spacing between labels. Since all the labels you 

specified above must fit on the page, increasing the margins or spacing will 

decrease the size of the labels. This may make it necessary to go back and 

change the number of columns and the number of words (rows) in each 

column. To adjust margins and spacing: 
 

- Set the page margins by typing into the Top, Left, Right and 

Bottom Margin boxes. You may want to change the Unit to Inch or 

Centimeter (instead of Point) to make the margin sizes more 

familiar. You can also click the User Printer Margins to 

automatically pick margins that work on your printer. 
 

- Click in the Automatic Sizing check box and the labels will adjust 

automatically to fill up the page.  [Note: Automatic Sizing does not 

work correctly when the page has a landscape orientation. You will 

have to set the label size manually]. 

 
- Set the horizontal and vertical spacing between labels by typing into 

the Horizontal and Vertical Gap boxes. Since you can also control 

(see the Label Design section) how words are laid out in a label, it is 

usually not necessary separate the labels. 

 

- Leave the Methods section to no methods as WordSpring doesn’t use 

the element. 
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Label Design 
 

Next specify how the words and pronunciations will appear on each label. 

Remember, each word in the WordSpring [User Selections] list and each 

word-pronunciation pair are printed on a single label. 
 

 

Figure 5. Label Design panel of Label Editor. 

 

- Select the Label tab at the top of the panel. The Label design 

panel will appear (shown in Figure 5). 
 

- First, make sure that the Form to Use drop-down menu at the top 

right of the page is selected with “No Form”. 
 

- Drag the fields that you want in the labels (if they are not already 

shown on the label)--word, word and pronunciation, or 

pronunciation alone--from the List of Fields window on the upper 

left into the white label in the Label Preview area to its right. 
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- Select text fields by clicking on them and then click on the large 

“T” inside the box at the top right immediately above the label 

window to choose the Font, Font Size and Alignment and Style 

options (bold, italic, color, or underlined) you want. Select then 

from the drop-down menu that appears when you click the T button. 

[Note: For pronunciations to print correctly you must choose the 

LPCourier font. Any font can be used for words]. 
 

- Align the text fields in the label by adjusting location so that you 

have sufficient margins around the words. 
 

- You may want pronunciations to the right of its corresponding 

word or below it. Move the pronunciation field so that it is 

aligned properly with its word. 
 

- Once you completed your selections you can click on preview to 

see the layout using your word list. 

 

Saving Print Formats 
 

To save the label you have just designed: 
 

- Click on the Save button at the top of the dialog box. A 

standard file dialog box will appear. 
 

- Select the file folder in which you want to store your label 

format. We recommend that you save new label formats in a 

folder of your choice in our documents folder so they can be 

found at a later date.  
 

- Give an appropriate file name to the print format. Give each 

printing format a distinguishing file name (e.g. Words, 3 columns 

XL vertical). Remember for landscape include the word horizontal 

in the name. 
 

- Click Save. Your format will be saved in the selected folder. Next 

click the Close (x) button at the top corner of the panel to exit the 

Label Editor and you will see a dialog asking whether your format 

is a list or a label. Select list unless you have designed the format to 

print on label stock. Always close the Label editor before editing 

the next format. 
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- Click Done on the Edit Templates dialog that appears. You will be 

returned to the WordSpring main panel and be ready to use this new 

template. 

 

Verifying a Print Format 
 

The best way to determine whether the print format you just designed is 

satisfactory is to create a sample word list in User Selections and print it. If 

changes are needed, you can edit the format by opening the label editor and 

loading the format to be edited as described at the beginning of this Chapter. 

You can also print and verify a printing format before saving the format by 

clicking the Preview button in the Label Editor panel. We recommend that 

you save your design as soon as it is completed to avoid losing your work if 

there should be a computer problem. 

 

Importing List and Label Templates 
 

To facilitate distribution of new printing formats, the Utility menu in the 

menu bar has two special commands: Import List Template and Import Label 

Template. These commands open a standard open file dialog screen that you 

can use to find the folder containing the templates you want and then click 

Open. The templates will be imported into your printing format database for 

future use. The WordSpring 3.1 folder contains the WS Printing Formats 

within the Documentation folder that have already been imported into 

WordSpring. If you accidentally deleted one of the formats from WordSpring 

you can recover it by importing from this folder. We may distribute 

additional printing templates by e-mail or have them available on our web 

site for downloading. 
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Support 
 

If you have a problem using WordSpring that you can’t resolve, we are 

ready to help. You can reach us in the following ways: 

 

Electronic Mail 
 

info@LexiaNet.org 
 

Electronic mail is the best way to reach us. Write down your problem as 

thoroughly as you can. Make a detailed record of the problem and the steps 

preceding the problem. E-mail this to us with your phone number and the 

best time to reach you. We will send a resolution as soon as possible or 

give you a call to discuss the problem. 

 

Phone 
 

(503) 703 4383 
 

If you cannot reach us by e-mail, or if the problem requires a discussion, call 

WordSpring support at The Lexia Institute. You can leave a voice mail 

message at any time. Let us know how to call you back and what times are 

best. Also leave your e-mail address. Support staff will be available to assist 

you either immediately or by arranging a mutually acceptable time, weekdays 

and weekends included. 

 

Mail 
 

The Lexia Institute 

620 Sand Hill Rd, Suite 116F  

Palo Alto, CA 94304 
 
 

We can also be reached by regular mail at the address above. Again, write 

down your problem as thoroughly as you can. Include a detailed record of the 

problem and the steps preceding the problem. Mail this to us. We will send a 

resolution as soon as possible. Please include your e-mail address and your 

phone number so that we can contact you immediately. 
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